
   

   
C H A P T E R 5

Simulation

WAE Design network simulations calculate demand routings and traffic distributions through the 
network based on the given traffic demand, network topology, configuration, and state. Simulation is the 
fundamental capability of WAE Design on which most of the other tools are built, including those for 
planning, traffic engineering, and worst-case failure analysis. A number of protocols and models are 
supported, including IGP, MPLS RSVP-TE, BGP, QoS, VPNs, Multicast, and Layer 1 (L1). 

This chapter focuses on the general features of WAE Design simulations. The individual protocols and 
models are described in their respective chapters. 

Simulations can be performed under different simulation convergence modes (Fast Reroute, IGP and 
LSP Reconvergence, and Autobandwidth Convergence), depending on which stage of the network 
recovery after failure is being investigated. If in Autobandwidth simulation mode, the results for 
simulations with failures are identical to those in the IGP and LSP Reconvergence simulation mode. The 
default simulation mode is IGP and LSP Reconvergence, and except where identified, the documentation 
describes this simulation mode. For more information, see the RSVP-TE Simulation chapter.

Simulation
WAE Design uses demands to simulate traffic between source and destination endpoints within a 
network. Each demand has a specified amount of traffic.

By default, an up-to-date simulation of an open plan is always available. Any change in the plan that 
affects or invalidates the current simulation automatically triggers a resimulation. Types of changes that 
result in re-simulations are those that would typically affect routing in a network.

• Changes in topology, such as adding and deleting objects or changing explicit paths.

• Changes to an object’s state, such as failing an object or making it inactive.

• Changes in numerous properties, such as metrics, capacities, and delay.

To toggle automatic resimulation on and off, follow one of these two steps.

• Select the drop-down arrow next to the Simulation On/Off icon (white arrow in green circle) in the 
Visualization toolbar. Click the “Auto resimulate” option to toggle it on and off.

• Select the Tools->Simulator->On/Off menu.
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State
The state of an object affects simulation and determines whether an object is operational. 

• Failed State—Identifies whether the object is failed. See the Failed State section.

• Active State—Identifies whether the object is available for use in the simulated network. For 
example, an object might be unavailable because it has been set administratively down. See the 
Active State section.

• Operational State—Identifies whether an object is operational. For instance, an object might be 
non-operational because it is failed, is inactive, or because other objects on which it depends are not 
operational. See the Operational State section.

The Failed and Active columns in the tables show a visual representation of their status. Likewise, you 
can show the Operational column to show the calculated operational state. In each column, T means the 
object is in that state and F means it is not. Note that the T or F for Active state in the Interfaces table is 
reflective of the associated circuit. The plot shows graphical representations of these states with crosses 
of various colors and fills.

Failed State
The quickest way to see the effects of failures in a Simulated Traffic view is to have demands in place 
and then fail an object. The plot immediately displays where the traffic increases as a result (Figure 5-1), 
and the Util Sim column in the Interfaces table reflects the traffic changes. Demands are then rerouted 
around the failure (Figure 5-2).

To specify that a demand should not reroute around failures, deselect the Reroutable option in the 
demand’s Properties dialog box. This can be used as a way of including L2 traffic on an interface. For 
example, a one-hop, non-reroutable demand can be constructed over the interface to represent the L2 
traffic. Other, reroutable, demands, can be constructed through the interface as usual. If the interface 
fails, the L2 traffic is removed and the L3 traffic reroutes. 

You can simultaneously fail one or more objects of the same type. If you select an interface to fail, you 
are actually failing its associated circuit.

Note For detailed information about visual representations of failed states, see the Plot Legend for Design 
Layouts chapter.

Objects That Can Be Failed

• Circuits

• Nodes

• Sites

• Ports

• Port circuits

• SRLGs

• L1 links

• L1 nodes

• External endpoint members
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Figure 5-1 Failed Circuit

Figure 5-2 Reroute of Demand Around Failed Circuit

Fail and Recover Objects

Fail Objects Recover Objects

From Context Menu 1. Select one or more objects.

2. Right-click one, and select Fail from the 
context menu.

1. Right-click in an empty plot area.

2. Either select All to recover all failed objects or 
individually select an object to recover it.
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Protect Circuits within SRLGs

You can protect circuits from being included in SRLG failures and SRLG worst-case analysis, though 
there are differences in behavior, as follows.

• These circuits do not fail if you individually fail an SRLG as described in the above steps. However, 
if you fail the circuit itself, it will fail.

• These circuits are protected from being included in Simulation Analysis regardless of whether they 
are in an SRLG or not. For more information, see the Simulation Analysis chapter.

Note that this setting has no effect on how FRR SRLGs are routed. For information on FRR SRLGs, see 
the RSVP-TE Simulation chapter.

Step 1 Set the Protected property for circuits.

a. Select one or more circuits.

b. Right-click a selected circuit, and select Properties from the context menu. 

c. Select the Protected option, and click OK.

Step 2 Set the Network Option property for protecting circuits included in SRLGs.

a. Select the Edit->Network Options menu or the Network Options icon from the Visualization toolbar.

b. Select the Simulation tab.

c. Select the option to exclude protected circuits from SRLG failures, and click OK.

Active State
An active/inactive state identifies whether an object is available for measured or simulated traffic 
calculations. An object can be inactive for one of three reasons.

From Properties 
Dialog Box

1. Select one or more objects.

2. Right-click one, and select Properties from 
the context menu.

3. Select the Failed option, and click OK.

1. Select one or more objects.

2. Right-click one, and select Properties from the 
context menu.

3. Deselect the Failed option, and click OK.

Fail Objects Recover Objects
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• It is administratively down.

• It is a placeholder. For instance, you might be planning to install an object and want its 
representation in the network plot.

• It exists in a copied template plan, but was not in the original plan that was discovered. 

You can simultaneously change the active state of one or more objects. If you change the active state of 
an interface, you are actually changing its associated circuit. 

Note For detailed information about visual representations of inactive states, see the Plot Legend for Design 
Layouts chapter.

Like failures, changing an object from active to inactive immediately affects how demands are routed, 
and affects the Util Sim column in the Interfaces tables (Figure 5-3). 

Figure 5-3 Inactive Circuit

Objects That Can Be Set to Inactive

• Circuits

• Nodes

• Sites

• Ports

• Port circuits

• SRLGs

• L1 links

• L1 nodes

• External endpoint members

• Demands

• LSPs

• LSP paths
5-5
Cisco WAE Design 6.3 User Guide

   



   

Chapter 5      Simulation
  Simulated Capacity
Set Active or Inactive States

Step 1 Right-click one or more like objects from their respective tables. The Properties dialog box appears. 

Step 2 Click the Active check box to toggle it on or off. A check mark means the object is active. Then click OK.

Operational State
The operational state identifies whether the object is functioning. You cannot set an operational state; 
rather, it is automatically calculated based on the failed and active states.

• Any object that is failed or inactive is operationally down.

• If the object relies on other objects that comprise it to be functioning, then its operational state 
mirrors the state of those objects. 

Note For detailed information about visual representations of non-operational states, see the Plot Legend for 
Design Layouts chapter.

Simulated Capacity
The Capacity column displays the configured physical capacity of interfaces, circuits, ports, and port 
circuits. Each circuit, port, and port circuit has a physical capacity that you can set in the Capacity field 
of the Properties dialog box. The interfaces have a configurable capacity that you can set in the 
Configured Capacity field. From these properties, a simulated capacity (Capacity Sim) is derived for 
each object.

The Capacity Sim column is the calculated capacity of the object given the state of the network, which 
could include failures that reduce capacity. All utilization figures in the Interfaces, Circuits, and 
Interface Queues tables are calculated based on this Capacity Sim value. When referencing the Capacity 
Sim value, there are a few rules to note regarding its calculation.

• If a circuit's Capacity is specified, this becomes the Capacity Sim of the circuit, and all other 
capacities (interface and constituent port capacities) are ignored. Specifying circuit capacities 
(rather than interface capacities) is the simplest way to modify existing capacities, which is useful, 
for example, for build-out planning. 

If This Object Fails or Is 
Inactive Then These Objects Will Be Operationally Down

Node Circuits connected to the failed node

Site Sites, nodes, and circuits within the failed site

SRLG Objects within the failed SRLG

Port Port circuits that contain the failed port
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• If the circuit has no Capacity, then its Capacity Sim is the minimum of its constituent interface 
Capacity values. The interface Capacity is the sum of the Capacity values of the associated ports. If 
the interface has no ports or if the ports have no Capacity, it is the same as the interface's Configured 
Capacity property. (Note the field in the interface Property dialog box is “Configured Capacity,” 
while the column name in the Interfaces table is “Capacity.”) 

• If two ports are connected explicitly by a port circuit, the Capacity Sim of the port circuit is set to 
the minimum capacity of the three, which effectively negotiates down the capacity of each side of 
the connection.

• If two ports are connected implicitly by an L1 circuit, then the Capacity Sim of the two ports is set 
to the minimum Capacity of the two, which again, effectively negotiates down the capacity of each 
side of the connection.

• In a LAG interface, if any of the constituent LAG members are operationally down, then the 
interface Capacity Sim column displays a value that is reduced by the aggregate capacity of all the 
LAG members that are down. For example, if a 1,000 Mbps port of a four-port 4,000-Mbps LAG is 
operationally down, the simulated capacity for that LAG interface becomes 3,000 Mbps. 

Note If a pair of ports is considered in Capacity Sim calculations, both must be operational to be considered.

Simulated Delay and Distance
Both Delay and Distance are properties that can be set in the circuit Properties dialog box. To automate 
the process of setting these, use the Latency and Distance Initializer. For information, see the Latency 
and Distance Initializer section.

All WAE Design delay calculations that use the L3 circuit delay, such as Metric Optimization, use the 
Delay Sim value. 

Circuits Table 
Column Description

Delay One-way transmission latency over the circuit in milliseconds (ms).

Distance Distance of the circuit in kilometers (km).
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For more information on the delay and distance of L1 objects, see the Layer 1 Simulation chapter.

Latency and Distance Initializer
Following is the default behavior for the Latency and Distance Initializer. Note that if there are no 
Longitude and Latitude available for use by the initializer, The Distance and Delay properties are set to 
zero.

• L1 Defaults

– The current L1 circuits Delay and Distance properties are removed unless the “Keep existing 
distances if available” option is selected. 

– The L1 node and L1 waypoint Longitude and Latitude properties are used to estimate the L1 
distances. If an L1 node does not have these properties set, the shortest distance calculation is 
based these same properties of its immediate parent site, if applicable. (L1 nodes are not 
required to have parent sites.) The L1 link delays are calculated from these distances.

– Each L1 circuit path’s Distance Sim and Delay Sim columns are calculated as the sum of the 
distances and delays of L1 links over which the L1 circuit path is routed. 

• L3 Defaults

– L3 circuit delays and distances are inherited from L1 circuits if there are L1 circuits mapped to 
the L3 circuits. Otherwise, the L3 delay and distance are estimated using the shortest distance 
between nodes at the endpoints of the circuits. If a node does not have Longitude and Latitude 
properties, the calculation is based on these same properties of its immediate parent site, if 
applicable. (Nodes are not required to have parent sites.) Thus, if you have an L1 model, the 
delays and distances are more precise because the physical paths that the L3 circuits take are 
known.

– ITU G.826 adjustments are used to convert L3 circuit distance (d) to an adjusted circuit distance 
(r) as follows. 

• If d < 1000, set r = 1.5 * d 

Delay Sim • (Derived) If the circuit Delay value is entered, it is copied to the Delay Sim column.

• If no Delay is explicitly set, the Delay Sim column in the Circuits table is copied from the L1 Delay Sim 
column of the mapped L1 circuit (if one exists), which is based on the L1 circuit path that is currently the 
active path.

• If no Delay is explicitly set and there is no mapped L1 circuit, the Delay Sim value in the Circuits table 
is copied from the maximum Delay Sim property of all associated port circuits. If none of these port 
circuits is mapped to an L1 circuit, then the Delay Sim value is set to 0.

• If there is no circuit Delay value, no associated L1 circuits, and no associated port circuits with Delay 
Sim values, the Delay Sim value is 0.

Distance Sim • (Derived) If the circuit Distance value is entered, it is copied to the Distance Sim column. 

• If no Distance is explicitly set for the circuit, the Distance Sim column in the Circuits table is copied from 
the L1 Distance Sim column of the mapped L1 circuit (if one exists), which is based on the L1 circuit 
path that is currently the active path.

• If the Distance is not specified (na) and if there are no L1 circuits mapped to the circuit, the Distance Sim 
column is 0.

Circuits Table 
Column Description
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• If 1000 <= d <= 1200, set r = 1500

• If d > 1200, set r = 1.25 * d
If this option is unchecked, set r equal to d. 

• Both the L3 and L1 delays are calculated to be the speed of light along a distance r, multiplied by 
the speed of light in medium correction factor (between 0 and 1). The default for this correction 
factor is 0.67. 

Step 1 This initializer can act on two different selected object types (L1 links and L3 circuits), so the defaults 
for the dialog box differ, depending both on selections and on how you access it. Regardless of the 
method, you can modify your selection options once the dialog box is opened. Following are guidelines 
for having the dialog box open with the most desirable defaults.

Step 2 In each section, Layer 1 and Layer 3, verify or change your selection to act on the desired objects.

To Calculate... Select These Objects Select This Menu

L1 link distance and delay, 
and L3 circuit delay

• No selections 

or

• One or more L1 links and one 
or more L3 circuits

Initializers->Latency and Distance menu.

L1 link distance and delay • No selections 

or

• One or more L1 links

Right-click an L1 link, and select Initialize Latency from the 
context menu.

L3 circuit delay • No selections 

or

• One or more L3 circuits

Use one of these options. 

• Right-click an L3 circuit, and select Initialize Latency 
from the context menu.

• Right-click a circuit or interface, and select Properties. 
Click the Estimate button next to the Delay field. This 
option is specific to L3 circuits. 
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• For L1 links, the default is to delete distances. To keep them, select the option to keep existing 
distances.

• For L1 circuit paths, the default is to inherit distance and delay from L1 links. If desired, use the L1 
Links drop-down list to base these calculations on all, selected, or tagged L1 links. If you do not 
want the distance and delay set on L1 circuit paths, select None.

• For L3 circuits, if desired, use the Circuits drop-down list to calculate L3 circuit delay and distance 
for all, selected, or tagged L3 circuits. If you do not want the delay or distance set on L3 circuits, 
select None. 

Verify the inclusion ITU G.826 adjustments in the calculation, which is the default and which is 
usually left unchanged.

Step 3 For both L1 links and L3 circuits, verify or change default speed of light factor of 0.67. This is usually 
left unchanged. Then click OK.

Related Topics
• Traffic Demand Modeling chapter

• Advanced Routing with External Endpoints chapter

• Simulation Analysis chapter

• IGP Simulation chapter

• MPLS Simulation chapter

• RSVP-TE Simulation chapter

• Segment Routing Simulation chapter

• Layer 1 Simulation chapter

• Quality of Service Simulation chapter

• BGP Simulation chapter
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• VPN Simulation chapter

• Multicast Simulation chapter

• Plot Legend for Design Layouts chapter (visualization of objects; visualization of failed, inactive, 
and non-operational states)
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